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Administratorhandbuch

Die folgenden Anweisungen gelten für Administratoren an Standorten mit dem Lizenztyp Lizenz für
gleichzeitig angemeldete Benutzer für IBM® SPSS Statistics 25. Mit dieser Lizenz können Sie IBM SPSS
Statistics auf beliebig vielen Computern installieren. Allerdings hängt die Anzahl der Benutzer, die die
Anwendung gleichzeitig ausführen können, davon ab, für wie viele Personen die Lizenz erworben wur-
de.

Vorbereitungen
Sie benötigen Ihren Autorisierungscode. Mit dem Autorisierungscode können Sie eine Lizenz für den
Concurrent License Manager abrufen. Der Concurrent License Manager steuert die Lizenz für gleichzei-
tig angemeldete Benutzer und ermöglicht den Endbenutzern die Ausführung von IBM SPSS Statistics.

Sie sollten separate Anweisungen zum Abrufen Ihres Autorisierungscodes erhalten haben. Wenn Sie den
Autorisierungscode nicht finden können, wenden Sie sich an den Kundendienst. Rufen Sie hierzu die Sei-
te http://www.ibm.com/software/analytics/spss/support/clientcare.html auf.

Führen Sie die folgenden Schritte aus, um sicherzustellen, dass Sie die Lizenz für gleichzeitig angemelde-
te Benutzer ordnungsgemäß eingerichtet haben:
1. Installieren Sie den Concurrent License Manager. Der Concurrent License Manager ist ein Dienst-

programm, das Endbenutzern die Lizenz für gleichzeitig angemeldete Benutzer bereitstellt. Sie können
den Lizenzmanager auf einem beliebigen Computer in Ihrem Netz speichern. In der Regel handelt es
sich dabei um einen Server, an den Desktop-Computer angeschlossen werden können. Weitere Infor-
mationen finden Sie in „Installieren des Concurrent License Managers” auf Seite 2.

2. Lizenzieren Sie das Produkt. Mit diesem Vorgang erhält der Lizenzmanager die für die Ausgabe der
Lizenzen erforderlichen Informationen. Weitere Informationen finden Sie in „Produktlizenzierung” auf
Seite 5.

3. Testen Sie den Concurrent License Manager. Sie sollten den Lizenzmanager testen, um sicherzustel-
len, dass er Lizenzen bereitstellt. Weitere Informationen finden Sie in „Testen des Lizenzmanagers”
auf Seite 8.

4. Installieren Sie IBM SPSS Statistics auf den lokalen Desktop-Computern. Sie oder Ihre Endbenut-
zer führen die vollständige Installation auf den Desktop-Computern durch. Während der Installation
kann der Endbenutzer den Computer angeben, auf dem der Lizenzmanager ausgeführt wird. Wenn
ein Endbenutzer versucht, IBM SPSS Statistics zu starten, fordert das Produkt bei diesem Lizenzmana-
ger einen Lizenzcode an. Wenn eine Lizenz verfügbar ist, wird IBM SPSS Statistics gestartet. Weitere
Informationen finden Sie in „Installieren des Produkts auf lokalen Desktop-Computern” auf Seite 9.

Für die Installation sind keine administrativen Schritte erforderlich. Sollten jedoch Probleme auftreten,
finden Sie in „Verwalten der Lizenz für gleichzeitig angemeldete Benutzer” auf Seite 14 weitere Informa-
tionen.

Erstellen eines Image
Sie können ein Image der Software erstellen, indem Sie den Lizenzmanager installieren und das Produkt
anschließend auf einem lokalen Desktop installieren, der zum Erstellen eines Images verwendet wird. Er-
stellen Sie nach Bedarf Images von zusätzlichen Computern.

Citrix- und Terminaldienste
Sie können die Anwendung IBM SPSS Statistics auf dieselbe Art auf dem Citrix- bzw. Terminaldienst-Ser-
ver installieren und den Benutzern zugänglich machen, auf die Sie andere Anwendungen für Windows
installieren und zugänglich machen.
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Gemischte Lizenzierung
IBM SPSS Statistics unterstützt gemischte Lizenzierungsumgebungen (eine Kombination aus lokalen Li-
zenzen für berechtigte Benutzer und Lizenzen für gleichzeitig angemeldete Benutzer) nur in einge-
schränktem Maße. In einer typischen Umgebung werden sämtliche Lizenzen entweder lokal oder über
den Concurrent License Manager verwaltet. Wenn das Hauptprodukt beispielsweise über den Concurrent
License Manager lizenziert ist, werden Zusatzmodule ebenfalls über den Concurrent License Manager li-
zenziert.

Eine gemischte Lizenzierung ist nur möglich, wenn das Hauptprodukt über den Concurrent License Ma-
nager lizenziert und die Zusatzmodule auf dem Computer des Endbenutzers mit licenseactivator lizenziert
werden. Installieren Sie IBM SPSS Statistics mit einer Lizenz für gleichzeitig angemeldete Benutzer, um
diese Art der gemischten Lizenzierung einzurichten. Verwenden Sie dann licenseactivator auf dem Compu-
ter des Endbenutzers, um die Zusatzmodule zu lizenzieren. Weitere Informationen zu licenseactivator fin-
den Sie in „Verwenden von 'licenseactivator' zur automatischen Installation einer Lizenz” auf Seite 6.

IBM SPSS Statistics unterstützt das umgekehrte Szenario nicht, bei dem das Hauptprodukt lokal und die
Zusatzmodule über den Concurrent License Manager lizenziert werden.

Installieren des Concurrent License Managers
Bevor Endbenutzer IBM SPSS Statistics auf ihrem Desktop-Computer installieren, müssen Sie den Con-
current License Manager installieren. Dieses Dienstprogramm ist ein fortlaufend ausgeführter Service
oder Dämonprozess, der in der Regel auf einem Computer im Netz installiert wird. (Sie haben auch die
Möglichkeit, ihn auf mehreren Computern zu installieren, wobei Sie redundante Lizenzmanager einrich-
ten müssen. Weitere Informationen finden Sie in „Einrichten von redundanten Lizenzservern” auf Seite
15.) Der Concurrent License Manager wird nicht auf den Desktop-Computern der Endbenutzer installiert.

Immer wenn ein Endbenutzer eine der Lizenz für gleichzeitig angemeldete Benutzer unterliegende IBM
SPSS-Anwendung startet, fordert die Anwendung eine Lizenz vom Lizenzmanager an. Dieses Dienstpro-
gramm gibt Lizenzen bis zu einer festgelegten Anzahl gleichzeitiger Endbenutzer aus, die sich aus der
von Ihnen erworbenen Lizenz ergibt. Wenn diese Anzahl erreicht ist, werden weitere Anfragen nach Li-
zenzen zurückgewiesen. Wenn Sie feststellen, dass Endbenutzern häufig Lizenzen verweigert werden, er-
kundigen Sie sich bei dem für Sie zuständigen Händler nach einer Lizenz für eine größerer Anzahl
gleichzeitiger Benutzer.

Lizenzmanager sind auf einer separaten DVD/CD verfügbar. Sie können auch als eImage heruntergela-
den werden.

Anmerkung: Der Lizenzmanager zeichnet die Anzahl aktiver Endbenutzersitzungen sowie Informationen
zu diesen einzelnen Sitzungen in einer Protokolldatei auf, die Sie dann zur Fehlerbehebung bei Verbin-
dungsproblemen heranziehen können. Weitere Informationen finden Sie in „Abrufen von
Protokollinformationen” auf Seite 15.

Mehrere Betriebssysteme

Die Plattform, auf der der Concurrent License Manager ausgeführt wird, muss nicht mit der Plattform
übereinstimmen, auf der der Client aktiv ist. Zum Beispiel kann ein Linux-Lizenzmanager Lizenzen für
Windows-Clients bereitstellen.

Verwalten des Lizenzmanagers

Der Lizenzmanager wird mithilfe des Lizenzmanageradministrators verwaltet, der nur für Windows ver-
fügbar ist. Beachten Sie deshalb, dass Sie mindestens einen Windows-System benötigen, auf dem der Li-
zenzmanageradministrator installiert ist.
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Systemanforderungen

Der Computer, auf dem der Concurrent License Manager installiert werden soll, muss folgende Anforde-
rungen erfüllen. Für den Lizenzmanager ist kein Serverklassencomputer erforderlich.
v Prozessor mit mindestens 550 Mhz
v Mindestens 128 MB RAM

Wichtig: Wenn auf dem Computer, auf dem der Lizenzmanager installiert ist, eine Firewall aktiv ist,
müssen Sie Port 5093 für UDP öffnen. Andernfalls können die Client-Computer keine Lizenz vom Lizenz-
manager abrufen. Wenn Sie darüber hinaus redundante Lizenzmanagercomputer verwenden, müssen Sie
Port 5099 für UDP öffnen, damit die Lizenzmanagercomputer untereinander kommunizieren können.

Durchführen eines Upgrades für den Lizenzmanager
Wenn Sie eine frühere Version des Lizenzmanagers installiert haben, müssen Sie die folgenden Schritte
durchführen:
1. Wechseln Sie in das Verzeichnis, in dem Sie den alten Lizenzmanager installiert haben.
2. Kopieren Sie die Datei lservrc. Windows: Suchen Sie im Verzeichnis winnt.
3. Speichern Sie die Datei lservrc an einem sicheren Ort.
4. Falls Benutzer Pendlerlizenzen ausgecheckt haben, stellen Sie sicher, dass diese Lizenzen wieder ein-

gecheckt werden. Informationen zum Abrufen einer Liste der ausgecheckten Lizenzen finden Sie in
„Konfigurieren von Pendlerlizenzen” auf Seite 17.

5. Fahren Sie den Lizenzmanager herunter. Weitere Informationen finden Sie in „Starten und Stoppen
des Lizenzmanagers” auf Seite 19.

6. Deinstallieren Sie den alten Lizenzmanager. Weitere Informationen finden Sie in „Deinstallieren des
Lizenzmanagers” auf Seite 20.

7. Installieren Sie den neuen Lizenzmanager. Informationen zum Installieren unter Windows finden Sie
in „Installieren des Lizenzmanagers unter Windows”. Informationen zum Installieren unter UNIX/
Linux finden Sie in „Installieren des Lizenzmanagers unter anderen Betriebssystemen als Windows”
auf Seite 4. Weitere Informationen zum Installieren unter Mac OS finden Sie in „Installieren des Li-
zenzmanagers unter Mac OS” auf Seite 4.

8. Kopieren Sie die gespeicherte Datei lservrc in das Verzeichnis, in dem Sie den neuen Lizenzmanager
oder das Unterverzeichnis winnt des Installationsverzeichnisses unter Windows installiert haben.
Wenn Sie die Standardposition unter Windows akzeptiert haben, wechseln Sie in den Ordner
C:\Programme (x86)\Common Files\SafeNet Sentinel\Sentinel RMS License Manager\WinNT.

Installieren des Lizenzmanagers unter Windows

Anmerkung: Sie müssen das Installationsprogramm als Administrator starten. Wenn Sie aufgefordert
werden, eine Installationsdatei zu starten, klicken Sie mit der rechten Maustaste auf die Datei und wählen
Als Administrator ausführen aus.

Anmerkung: Stellen Sie sicher, dass auf dem Computer, auf dem Sie die Installation durchführen, Java
installiert ist.
1. Legen Sie die DVD/CD mit den parallelen Lizenzierungstools in das DVD/CD-Laufwerk des

Netzcomputers ein, auf dem der Lizenzmanager ausgeführt werden soll. Kopieren Sie das Archiv, das
den Lizenzmanager und die Lizenztools für Ihr Windows-Betriebssystem enthält, von der DVD/CD.
ODER:
Wenn Sie eine eImage-Datei heruntergeladen haben, können Sie mit einem Archivierungsprogramm
wie WinZip alle Dateien im entsprechendem eImage extrahieren.

2. Extrahieren Sie den Inhalt des Archivs, das den Lizenzmanager und die Lizenztools enthält.
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3. Führen Sie die Datei setup.exe im extrahierten Verzeichnis manager aus und folgen Sie den am Bild-
schirm angezeigten Anweisungen.

4. Führen Sie die Datei setup.exe im extrahierten Verzeichnis tools aus und folgen Sie den am Bild-
schirm angezeigten Anweisungen, um den Lizenzmanageradministrator auf demselben Computer wie
den Lizenzmanager zu installieren. Sie können den Lizenzmanageradministrator auch auf einem an-
deren Windows-Computer installieren, wenn Sie den Lizenzmanager remote verwalten möchten.

Installieren des Lizenzmanagers unter Mac OS
1. Legen Sie die DVD/CD mit den parallelen Lizenzierungstools in das DVD/CD-Laufwerk des

Netzcomputers ein, auf dem der Lizenzmanager ausgeführt werden soll. Suchen Sie das Archiv, das
den Lizenzmanager und die Lizenztools für Ihr Betriebssystem enthält.
ODER:
Wenn Sie eine eImage-Datei heruntergeladen haben, wechseln Sie zu dem Speicherort, an den Sie die
Datei heruntergeladen haben.

2. Extrahieren Sie den Inhalt des Archivs, das den Lizenzmanager und die Lizenztools enthält, an dem
Speicherort, an dem Sie den Lizenzmanager installieren wollen.

3. Installieren Sie den Lizenzmanageradministrator auf einem Windows-System. Weitere Informationen
finden Sie in „Installieren des Lizenzmanageradministrators”.

4. Weitere Informationen zum Starten des Lizenzmanagers finden Sie in „Starten und Stoppen des
Lizenzmanagers” auf Seite 19.

Installieren des Lizenzmanagers unter anderen Betriebssystemen als
Windows
1. Legen Sie die DVD/CD mit den parallelen Lizenzierungstools in das DVD/CD-Laufwerk des

Netzcomputers ein, auf dem der Lizenzmanager ausgeführt werden soll. Suchen Sie das Archiv, das
den Lizenzmanager und die Lizenztools für Ihr Betriebssystem enthält.
ODER:
Wenn Sie eine eImage-Datei heruntergeladen haben, wechseln Sie zu dem Speicherort, an den Sie die
Datei heruntergeladen haben.

2. Extrahieren Sie den Inhalt des Archivs, das den Lizenzmanager und die Lizenztools enthält, an dem
Speicherort, an dem Sie den Lizenzmanager installieren wollen.

3. Installieren Sie den Lizenzmanageradministrator auf einem Windows-System. Weitere Informationen
finden Sie in „Installieren des Lizenzmanageradministrators”.

4. Weitere Informationen zum Starten des Lizenzmanagers finden Sie in „Starten und Stoppen des
Lizenzmanagers” auf Seite 19.

Installieren des Lizenzmanageradministrators
Der nur für Windows verfügbare Lizenzmanageradministrator wird für die Verwaltung des Lizenzmana-
gers verwendet. Wenn Sie den Lizenzmanager auf einem Nicht-Windows-System installiert haben, müs-
sen Sie den Lizenzmanageradministrator auf einem Windows-System installieren.
1. Legen Sie die DVD/CD mit den parallelen Lizenzierungstools in das DVD/CD-Laufwerk des Win-

dows-Netzcomputers ein, auf dem der Lizenzmanageradministrator ausgeführt werden soll. Kopieren
Sie das Archiv, das den Lizenzmanager und die Lizenztools enthält, von der DVD/CD.
ODER:
Wenn Sie eine eImage-Datei heruntergeladen haben, können Sie mit einem Archivierungsprogramm
wie WinZip alle Dateien im entsprechendem eImage extrahieren.

2. Extrahieren Sie den Inhalt des Archivs, das den Lizenzmanager und die Lizenztools enthält.
3. Führen Sie die Datei setup.exe im extrahierten Verzeichnis tools aus und folgen Sie den am Bild-

schirm angezeigten Anweisungen.
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Produktlizenzierung
Auf Nicht-Windows-Betriebssystemen müssen Sie die Lizenz nach der Installation des Lizenzmanagers
über die Eingabeaufforderung installieren.

Anmerkung: Lizenzen sind mit einem Sperrcode an die physische oder virtuelle Hardware des
Netzcomputers gebunden. Wenn Sie den Netzcomputer oder die zugehörige Hardware austauschen, be-
nötigen Sie einen neuen Sperrcode und müssen bei Ihrem Vertriebsbeauftragten einen neuen Autorisie-
rungscode anfordern. Bei Installationen auf einer virtuellen Maschine müssen Sie sicherstellen, dass Sie
einen Sperrcode auswählen, der sich beim Neustart nicht ändert. Weitere Informationen finden Sie in „In-
stallieren einer Lizenz in einer virtuellen Umgebung”.

Wichtig: Die Lizenz reagiert auf Änderungen der Systemzeit. Wenn Sie die Systemzeit ändern müssen
und dann das Produkt nicht mehr ausführen können, fordern Sie Unterstützung durch das Kunden-
betreuungsteam über die Seite http://www.ibm.com/software/analytics/spss/support/clientcare.html
an.

Installieren einer Lizenz in einer virtuellen Umgebung
Es gibt spezielle Lizenzierungsanweisungen für Installationen des Concurrent License Managers in einer
virtuellen Umgebung. Bei einer virtuellen Maschine ist die Hardware virtuell und der Sperrcode, mit dem
der Lizenzmanager an die Lizenz gebunden ist, kann sich beim Neustart der virtuellen Maschine ändern.
Sie müssen einen Sperrcode finden, der sich beim Neustart der virtuellen Maschine nicht ändert, um si-
cherzustellen, dass der Lizenzmanager ordnungsgemäß funktioniert. Wenn Sie einen stabilen Sperrcode
finden, verwenden Sie ihn für die Lizenzierung des Lizenzmanagers.

Wichtig:

Wenn Sie einen Sperrcode auswählen, der sich beim Neustart ändert, funktioniert der Lizenzmanager
nicht mehr. Die IBM SPSS-Anwendung kann keine Lizenz abrufen und daher nicht gestartet werden.

Prüfen des Sperrcodes
1. Öffnen Sie eine Eingabeaufforderung.
2. Wechseln Sie in das folgende Verzeichnis.
v Windows. Das Installationsverzeichnis für den Lizenzmanageradministrator. Wenn Sie während der

Installation die Standardposition akzeptiert haben, lautet das Installationsverzeichnis für den Li-
zenzmanageradministrator C:\Programme (x86)\IBM\SPSS License Tools\9.7.0.0.

v Andere Plattformen. Das Installationsverzeichnis für den Lizenzmanager.
3. Geben Sie an der Eingabeaufforderung echoid (Windows) oder ./echoid (andere Plattformen) ein.

Es wird eine Ausgabe ähnlich der folgenden angezeigt:

Locking Code 1 : 4-12A1B

Die unmittelbar vor dem Bindestrich (-) angezeigte Zahl ist das Sperrcodekriterium. Das Sperrcodekriteri-
um ist eine Zahl, die die virtuelle Hardware darstellt, die für den Sperrcode verwendet wird (in diesem
Beispiel ist dies 4 und stellt die Datensatz-ID des Datenträgers mit dem Betriebssystem dar). Die Zahl
hinter dem Bindestrich ist der Sperrcode (in diesem Beispiel ist dies 12A1B).

Mögliche Sperrcodekriterien:

Sperrcodekriterium Virtuelle Hardware

2 IP-Adresse

4 Datensatz-ID des Datenträgers mit dem Betriebssystem
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Sperrcodekriterium Virtuelle Hardware

8 Hostname

10 Ethernet-Karte

Prüfen, ob der Sperrcode stabil ist
1. Starten Sie die virtuelle Maschine nach der Prüfung des Sperrcodes neu.
2. Prüfen Sie den Sperrcode erneut (siehe „Prüfen des Sperrcodes” auf Seite 5).
v Wenn sich der Sperrcode nicht ändert, starten Sie neu und prüfen Sie den Sperrcode mehrmals.

Wenn der Sperrcode stabil ist, können Sie die Lizenzierung durchführen (siehe „Lizenzierung des
Lizenzmanagers mit dem neuen Sperrcode”).

v Wenn sich der Sperrcode ändert, müssen Sie ihn aktualisieren (siehe „Aktualisierung des Sperr-
codes”).

Aktualisierung des Sperrcodes
1. Öffnen Sie die Datei echoid.dat, die sich im folgenden Verzeichnis befindet, in einem Texteditor.
v Windows. Das Installationsverzeichnis für den Lizenzmanageradministrator. Wenn Sie während der

Installation die Standardposition akzeptiert haben, lautet das Installationsverzeichnis für den Li-
zenzmanageradministrator C:\Programme (x86)\IBM\SPSS License Tools\9.7.0.0.

v Andere Plattformen. Das Installationsverzeichnis für den Lizenzmanager.
2. Es wird eine Hexadezimalzahl angezeigt, die das aktuelle Sperrcodekriterium darstellt. Ändern Sie

diese Zahl in ein zulässiges Sperrcodekriterium im Hexadezimalformat.

Sperrcodekriterium im Hexadezimalformat Virtuelle Hardware

0x002 IP-Adresse

0x004 Datensatz-ID des Datenträgers mit dem Betriebssystem

0x008 Hostname

0x010 Ethernet-Karte

Lizenzierung des Lizenzmanagers mit dem neuen Sperrcode

Wenn Sie einen stabilen Sperrcode gefunden und eine entsprechende Aktualisierung durchgeführt haben,
gibt es keine weiteren spezifischen Lizenzierungsschritte für virtuelle Umgebungen. Beenden Sie die Ins-
tallation der Lizenz über die Eingabeaufforderung.

Installieren einer Lizenz über die Eingabeaufforderung

Sie haben zwei Möglichkeiten zur Installation über die Eingabeaufforderung. Sie können mithilfe von li-
censeactivator automatisch eine Lizenz aus dem Internet abrufen oder Sie können mithilfe von echoid
manuell eine Lizenz beziehen.

Verwenden von 'licenseactivator' zur automatischen Installation einer Lizenz
Der Computer, auf dem Sie die Lizenz installieren, muss mit dem Internet verbunden sein. Andernfalls
müssen Sie die Lizenz manuell installieren. Weitere Informationen finden Sie in „Manuelles Installieren
einer Lizenz” auf Seite 7.
1. Melden Sie sich mit demselben Benutzerkonto an wie bei der Installation des Lizenzmanagers.
2. Öffnen Sie eine Eingabeaufforderung und wechseln Sie in das Installationsverzeichnis des Lizenzma-

nageradministrators. Dies ist das Verzeichnis, in dem Sie den Lizenzmanageradministrator installiert ha-
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ben, nicht das Installationsverzeichnis von IBM SPSS Statistics. Wenn Sie die Standardposition unter
Windows akzeptiert haben, prüfen Sie den Ordner C:\Programme (x86)\IBM\SPSS License Tools\
9.7.0.0.

3. Normalerweise sind Sie im Besitz eines Autorisierungscodes. Im einfachsten Fall geben Sie Folgendes
an der Eingabeaufforderung ein. (Weitere Details zur Verwendung der Befehlszeile finden Sie unten.)
licenseactivator <Autorisierungscode>

Dabei ist <Autorisierungscode> Ihr Autorisierungscode.

Es sollte eine Nachricht angezeigt werden, dass die Lizenz erfolgreich hinzugefügt wurde. Andernfalls
notieren Sie sich den Fehlercode und versuchen Sie, die Lizenz manuell zu installieren. Weitere Informati-
onen finden Sie in „Manuelles Installieren einer Lizenz”.

Bei Verwendung von licenseactivator wird das Produkt lizenziert und eine Protokolldatei in das Pro-
duktverzeichnis geschrieben. Der Name der Protokolldatei ist licenseactivator_<Monat>_<Tag>_<Jahr>.log.
Wenn Fehler auftreten, können Sie gegebenenfalls der Protokolldatei weitere Informationen entnehmen.
Diese Informationen sind auch dann hilfreich, wenn Sie sich an den IBM Support wenden.

Verwenden von 'licenseactivator' mit Autorisierungscodes

licenseactivator wird in der Regel mit einem oder mehreren Autorisierungscodes verwendet, die Sie beim
Kauf des Produkts erhalten haben. Geben Sie den gesamten Text in einer einzigen Zeile ein.
licenseactivator Autorisierungscode1[:Autorisierungscode2:...:AutorisierungscodeN] [PROXYHOST=Proxy-Hostname]
[PROXYPORT=Proxy-Portnummer] [PROXYUSER=Proxy-Benutzer-ID] [PROXYPASS=Proxy-Kennwort]

v Mehrere Autorisierungscodes werden durch Doppelpunkte (:) getrennt.
v Die Proxy-Einstellungen sind optional, aber sie sind unter Umständen nötig, wenn sich Ihr Computer

hinter einem Proxy befindet. Welche Proxy-Einstellungen benötigt werden, hängt von der jeweiligen
Proxy-Konfiguration ab. Möglicherweise sind alle erforderlich.

PROXYHOST
Der Servername oder die IP-Adresse des Proxy-Hosts

PROXYPORT
Die Portnummer für die Internetverbindung über den Proxy

PROXYUSER
Falls erforderlich, die Benutzer-ID für den Proxy.

PROXYPASS
Falls erforderlich, das Kennwort für die Benutzer-ID

Verwenden von 'licenseactivator' mit Lizenzcodes

Eventuell hat Ihnen IBM eine Lizenz gesendet.
licenseactivator Lizenzcode[:Lizenzcode2:...:LizenzcodeN]

v Mehrere Lizenzcodes werden durch Doppelpunkte (:) getrennt.
v Bei Verwendung von Lizenzcodes stellt licenseactivator keine Verbindung zum Internet her, sodass Sie

keine Proxy-Informationen angeben müssen.

Manuelles Installieren einer Lizenz
1. Melden Sie sich mit demselben Benutzerkonto an wie bei der Installation des Lizenzmanagers.
2. Öffnen Sie eine Eingabeaufforderung und wechseln Sie in das Installationsverzeichnis des Lizenzma-

nageradministrators. Beachten Sie, dass dies der Ordner ist, in dem Sie den Lizenzmanageradministrator
installiert haben, nicht das Installationsverzeichnis von IBM SPSS Statistics. Wenn Sie die Standardpo-
sition unter Windows akzeptiert haben, prüfen Sie den Ordner C:\Programme (x86)\IBM\SPSS License
Tools\9.7.0.0.
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3. Rufen Sie den Sperrcode für den Server-Computer ab. Geben Sie an der Eingabeaufforderung echoid
(Windows) oder ./echoid (andere Plattformen) ein.

4. Rufen Sie unsere regionale Niederlassung an oder senden Sie eine E-Mail an spsscs@us.ibm.com und
teilen Sie IBM den Sperrcode und Ihren Autorisierungscode mit. IBM wird Ihnen anschließend einen
Lizenzcode oder eine Datei mit dem Lizenzcode bereitstellen.

5. Verwenden Sie licenseactivator zur Eingabe des bzw. der Lizenzcodes.

Aktivieren für die temporäre Verwendung
Wenn Sie die Lizenz nicht installiert haben, können Sie IBM SPSS Statistics für die temporäre Verwen-
dung aktivieren.
1. Wenn Sie über Installationsdatenträger verfügen, stellen Sie sicher, dass sich die DVD/CD im DVD/

CD-Laufwerk befindet. Wenn Sie ein eImage heruntergeladen haben, öffnen und/oder extrahieren Sie
den Inhalt des eImage.

2. Starten Sie die Anwendung WlmAdmin. Weitere Informationen finden Sie in „Starten der Anwendung
WlmAdmin” auf Seite 14.

3. Klicken Sie im linken Fensterbereich der Anwendung WlmAdmin auf das Zeichen + neben Subnet
Servers. Wenn der Lizenzmanagerserver nicht angezeigt wird, geben Sie den Computer an, indem Sie
im Menü "Edit" die Option Defined Server List auswählen.

4. Klicken Sie mit der rechten Maustaste auf den Netzcomputer, auf dem der Lizenzmanager ausgeführt
wird, und wählen Sie dann die folgenden Befehle aus:
Add Feature > From a File > To Server and its File

Hinweis: Wenn Sie To Server auswählen anstatt To Server and its File, werden die Informationen zur
temporären Verwendung im Arbeitsspeicher gespeichert. Diese Informationen gehen beim Neustart
des Netzcomputers verloren.

5. Geben Sie im Dialogfeld "Open" den Pfad D:\Windows\Administration\Licensing\
NeworkLicenseManager\lservrc.temp ein. Dabei steht D für das Laufwerk Ihres Installationsdatenträ-
gers. Wenn D nicht das Laufwerk Ihres Installationsdatenträgers ist, geben Sie den entsprechenden
Laufwerkbuchstaben ein. Wenn Sie ein eImage heruntergeladen haben, geben Sie
<eImage>\Administration\Licensing\NeworkLicenseManager\lservrc.temp ein. Dabei steht <eImage>
für den Speicherort, an dem Sie die eImage-Dateien geöffnet/extrahiert haben.

6. Klicken Sie auf OK, wenn die Anwendung Ihre Lizenz anzeigt. Informationen zum Anzeigen der Li-
zenzdetails finden Sie in „Anzeigen der Details zu einer Lizenz” auf Seite 15.

Hinzufügen einer Lizenz
Eventuell möchten Sie zu einem späteren Zeitpunkt eine Lizenz hinzufügen. Der Vorgang beim Hinzufü-
gen einer Lizenz ist identisch mit der Installation der originalen Lizenz.

Anzeigen der Lizenz
Sie können Ihre Lizenz für gleichzeitig angemeldete Benutzer (einschließlich der Anzahl der Benutzer) in
der Anwendung WlmAdmin anzeigen. Informationen zur Anwendung WlmAdmin und die Besonderhei-
ten beim Anzeigen der Lizenz finden Sie in „Verwalten der Lizenz für gleichzeitig angemeldete Benutzer”
auf Seite 14.

Testen des Lizenzmanagers
Um sicherzustellen, dass der Lizenzmanager die Lizenzen korrekt bereitstellt, sollten Sie ihn testen.
1. Wenn Sie den Lizenzmanageradministrator nicht auf einem anderen Computer installiert haben, ins-

tallieren Sie ihn auf einem Windows-System, auf dem der Lizenzmanager, den Sie testen möchten,
nicht läuft. Weitere Informationen finden Sie in „Installieren des Lizenzmanageradministrators” auf
Seite 4.
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2. Installieren Sie einen weiteren Lizenzmanager auf einem Windows-System, auf dem der Lizenzmana-
ger, den Sie testen möchten, nicht ausgeführt wird. Weitere Informationen finden Sie in „Installieren
des Lizenzmanagers unter Windows” auf Seite 3.

3. Starten Sie die Anwendung WlmAdmin. Weitere Informationen finden Sie in „Starten der Anwendung
WlmAdmin” auf Seite 14.

4. Fügen Sie den fernen Server des Lizenzmanagers hinzu, den Sie testen möchten. Weitere Informatio-
nen finden Sie in „Hinzufügen eines Servers” auf Seite 14.

5. Zeigen Sie die Lizenzen auf dem fernen Server an. Weitere Informationen finden Sie in „Anzeigen der
Details zu einer Lizenz” auf Seite 15.

Wenn Sie die Lizenzen anzeigen können, ist der Lizenzmanager bereit, dass lokale Desktop-Computer an-
geschlossen werden. Sie können mit der Installation des Produkts auf lokalen Desktop-Computern begin-
nen. Wenn Sie die Lizenzen nicht anzeigen können, überprüfen Sie die vorhergehenden Schritte, um si-
cherzustellen, dass der Lizenzmanager korrekt installiert wurde.

Installieren des Produkts auf lokalen Desktop-Computern

Anmerkung: Die Verbindung mit dem Concurrent License Manager über VPN wird nicht offiziell unter-
stützt.

Für die lokale Installation des vollständigen Produkts auf den Computern der Endbenutzer stehen Ihnen
zwei Optionen zur Verfügung: Sie können auf jedem Computer eine manuelle Installation durchführen
oder eine Anwendung wie Systems Management Server (SMS) verwenden, um die Installation auf Win-
dows-Computern durchzuführen. Sie haben außerdem die Möglichkeit, eine unbeaufsichtigte Installation
unter Mac und Linux durchzuführen.

Durchführen einer manuellen Installation auf einem lokalen Desktop-Computer
1. Stellen Sie die Installationsmedien zur Verfügung. Laden Sie das eImage für das Produkt herunter

und extrahieren Sie die Dateien auf einem freigegebenen Netzlaufwerk. Wenn Sie über Installationsda-
tenträger verfügen, erstellen Sie die benötigte Anzahl von Kopien der DVD/CD oder speichern Sie
die entsprechenden Dateien auf einem freigegebenen Netzlaufwerk

2. Kopieren Sie die Installationsanweisungen und bereiten Sie die Lizenzinformationen vor. Erstellen
Sie die benötigte Anzahl von Kopien der Installationsanweisungen für das Produkt. Die Installations-
anweisungen stehen auf der Download-Site bzw. im Falle von physischen Installationsmedien im Ver-
zeichnis /Documentation/<Sprache>/InstallationDocuments auf der DVD/CD zur Verfügung. Suchen Sie
nach den Anweisungen, die Ihrem Lizenztyp entsprechen. Nach der Installation müssen die Endbe-
nutzer die IP-Adresse oder den Namen des Netzcomputers eingeben, auf dem der Concurrent License
Manager ausgeführt wird. Tragen Sie diese Informationen an der dafür vorgesehenen Stelle am An-
fang der Anweisungen ein, bevor Sie diese kopieren.

3. Verteilen Sie die Installationsunterlagen und -medien an die Endbenutzer. Verteilen Sie die herun-
tergeladene Datei (bzw. den Netzspeicherort oder die Installations-DVD/CD), die Installationsanwei-
sungen und die Lizenzinformationen an die Endbenutzer, die auf den Computern bei Bedarf manuell
installieren können.

Übertragen der Installation unter Windows auf lokale Desktop-Computer

Da IBM SPSS Statistics-Installationen mit Microsoft Windows Installer (MSI) kompatibel sind, können Sie
die Installation automatisch auf die Desktop-Computer der Endbenutzer übertragen.

Übertragen einer Installation an Windows-Computer
Das Übertragen einer Installation ist eine Methode für die Fernverteilung von Software an eine beliebige
Zahl von Endbenutzern, ohne dass die Benutzer aktiv werden müssen. Sie können eine vollständige Ins-
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tallation von IBM SPSS Statistics auf die Computer der Endbenutzer unter Windows übertragen. Die für
die automatische Übertragung der Installation verwendete Technologie muss die Engine von MSI 3.0 oder
höher unterstützen.

Anmerkung: Die Übertragung einer Installation steht für Mac und Linux nicht direkt zur Verfügung.
Stattdessen können Sie eine unbeaufsichtigte Installation durchführen. Weitere Informationen finden Sie
in „Ausführen einer unbeaufsichtigten Installation auf Mac- und Linux-Computern” auf Seite 13.

Deinstallieren einer früheren Version
Wenn Sie die automatische Übertragung in ein Verzeichnis durchführen, in dem eine frühere Version von
IBM SPSS Statistics installiert wurde, muss die alte Version deinstalliert werden. Sie können die Deinstal-
lation ebenso wie eine Installation übertragen. Weitere Informationen finden Sie in „Automatische Über-
tragung einer Deinstallation” auf Seite 13.

Eigenschaften für automatisch übertragene Installationen
Nachfolgend finden Sie die Eigenschaften, die für automatisch übertragene Installationen verwendet wer-
den können. Bei allen Eigenschaften wird zwischen Groß- und Kleinschreibung unterschieden. Werte
müssen in Anführungszeichen angegeben werden, wenn sie Leerzeichen enthalten.

Tabelle 1. Eigenschaften für automatisch übertragene Installationen.

Eigenschaft Beschreibung Gültige Werte Standard
(sofern zutreffend)

INSTALLDIR Das Verzeichnis, in dem
IBM SPSS Statistics auf dem
Desktop-Computer des
Endbenutzers installiert
werden sollte. Diese Eigen-
schaft ist optional. Wird sie
nicht angegeben, wird der
Standardwert C:\Program
Files\IBM\SPSS\Statistics\
25 verwendet.

Ein gültiger Pfad, beispiels-
weise C:\Statistics.

C:\Program Files\IBM\
SPSS\Statistics\25

LICENSETYPE Der Lizenztyp. Bei diesem
Wert wird zwischen Groß-
und Kleinschreibung unter-
schieden.

Network

LSHOST Die IP-Adresse oder der
Name des Computers bzw.
der Computer im Netz, auf
dem bzw. denen der
Concurrent License Mana-
ger ausgeführt wird.

Eine oder mehrere gültige
IP-Adressen oder Namen
der Computer im Netz.
Mehrere Adressen oder Na-
men werden durch Tilden
getrennt (z. B.
Server1~Server2~Server3).

DISABLE_COMMUTE Inaktiviert die
Pendlerlizenzfunktion auf
dem Desktop-Computer
des Endbenutzers. Wenn
Pendlerlizenzen aktiviert
sind, werden auf dem
Desktop-Computer keine
Verknüpfungen für
Pendlerlizenzen installiert.
Weitere Informationen zu
Pendlerlizenzen finden Sie
in „Konfigurieren von
Pendlerlizenzen” auf Seite
17.

1 gibt an, dass die
Pendlerlizenzen
inaktiviert sind.
0 gibt an, dass die
Pendlerlizenzen aktiviert
sind.

1
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Tabelle 1. Eigenschaften für automatisch übertragene Installationen (Forts.).

Eigenschaft Beschreibung Gültige Werte Standard
(sofern zutreffend)

COMMUTE_MAX_LIFE Die maximale Anzahl
von Tagen, für die ein
Endbenutzer eine
Pendlerlizenz auschecken
kann. Weitere Informatio-
nen finden Sie in „Konfigu-
rieren von Pendlerlizenzen”
auf Seite 17.

Eine Zahl zwischen 1 und
30.

7

INSTALLPYTHON IBM SPSS Statistics - Essen-
tials for Python installieren.
Das Produkt umfasst Py-
thon Version 2.7 und 3.4,
das IBM SPSS Statistics -
Integration Plug-in for Py-
thon und eine Reihe von
Python-Erweiterungs-
befehlen, die Möglich-
keiten bieten, die über
die mit integrierten
SPSS Statistics-Prozeduren
bereitgestellten Möglichkei-
ten hinausgehen. Weitere
Informationen finden Sie
unter "Integration Plug-in
for Python" im Hilfesystem.

1 gibt an, dass IBM SPSS
Statistics - Essentials for
Python installiert wird.
0 gibt an, dass IBM SPSS
Statistics - Essentials for
Python nicht installiert
wird.

1

COMPANYNAME Der Name Ihres Unterneh-
mens.

Eine beliebige Zeichenfolge.

MSI-Dateien
Die Datei IBM SPSS Statistics 25.msi befindet sich im Verzeichnis Windows\SPSSStatistics\<Architektur>
auf der DVD/CD, wobei <Architektur> für 32bit oder 64bit steht. Nachdem Sie die Software heruntergela-
den haben, müssen Sie den Inhalt des eImage entpacken, um auf die MSI-Datei zugreifen zu können.

Beispiel für die Befehlszeile
Nachfolgend finden Sie eine Befehlszeile zur automatischen Übertragung einer Produktinstallation. Geben
Sie den gesamten Text in einer einzigen Zeile ein.
MsiExec.exe /i "IBM SPSS Statistics 25.msi" /qn /L*v logfile.txt
INSTALLDIR="C:\Statistics" LICENSETYPE="Network" LSHOST="mylicserver"

Automatisches Übertragen der Installation mithilfe von SMS
Die grundlegenden Schritte für die Verwendung von Systems Management Servers (SMS) für die automa-
tische Übertragung (Push) von IBM SPSS Statistics sind folgende:
1. Kopieren Sie das entsprechende Unterverzeichnis des Verzeichnisses Windows\SPSSStatistics\

<Architektur> auf der DVD/CD in ein Verzeichnis auf einem Netzcomputer. Wenn Sie die Software
heruntergeladen haben, müssen Sie den Inhalt des eImage zunächst entpacken.

2. Bearbeiten Sie die Datei IBM SPSS Statistics 25.sms im kopierten Verzeichnis. Bearbeiten Sie mithilfe
eines Texteditors den Wert von "CommandLine", indem Sie die entsprechenden Eigenschaften hinzu-
fügen. Eine Liste der verfügbaren Eigenschaften finden Sie in „Eigenschaften für automatisch übertra-
gene Installationen” auf Seite 10. Stellen Sie sicher, dass Sie die richtige MSI-Datei in der Befehlszeile
angeben.

Administratorhandbuch 11



3. Erstellen Sie ein Paket aus der Datei IBM SPSS Statistics 25.sms und verteilen Sie das Paket an die
Desktop-Computer der Endbenutzer.

Verwenden von Gruppenrichtlinie oder einer ähnlichen Technologie zur automati-
schen Übertragung der Installation
1. Kopieren Sie das entsprechende Unterverzeichnis des Verzeichnisses Windows\SPSSStatistics\

<Architektur> auf der DVD/CD in ein Verzeichnis auf einem Netzcomputer. Wenn Sie die Software
heruntergeladen haben, müssen Sie den Inhalt des eImage zunächst entpacken.

2. Mit einer Anwendung wie ORCA können Sie die Eigenschaftstabelle in der entsprechenden Datei IBM
SPSS Statistics 25.msi unter dem kopierten Ordner bearbeiten. ORCA ist Teil des Windows 2003 Server
SDK, das Sie unter http://www.microsoft.com/downloads finden, indem Sie nach dem SDK suchen.
Eine Liste der Eigenschaften, die in die Eigenschaftstabelle aufgenommen werden können, finden Sie
in „Eigenschaften für automatisch übertragene Installationen” auf Seite 10. Achten Sie darauf, dass Sie
die richtige MSI-Datei verwenden.

3. Erstellen Sie ein Paket aus der bearbeiteten Datei IBM SPSS Statistics 25.msi und verteilen Sie das Pa-
ket an die Desktop-Computer der Endbenutzer.

Automatische Übertragung der Installation auf ein nicht englisches System
Sie können sie ohne zusätzliche Spezifikation auf ein nicht englisches System übertragen. Allerdings sind
dann die Installationsanweisungen (bei der Übertragung einer interaktiven Installation), die Benutzer-
schnittstelle und die Hilfe auf Englisch. Die Anwender können nach der Installation die Benutzerschnitt-
stellensprache umstellen, es steht jedoch keine lokalisierte Hilfe zur Verfügung.

Sie können die Eigenschaft TRANSFORMS verwenden, um eine der MST-Dateien anzugeben, die auf der
DVD/CD oder im heruntergeladenen eImage vorhanden sind. Die MST-Datei stellt sicher, dass der Instal-
lationsassistent, die Benutzerschnittstelle und die Hilfe in der spezifizierten Sprache erscheinen. MST-Da-
teien sind nicht verfügbar, wenn Sie IBM SPSS Statistics heruntergeladen haben. Benutzer müssen die
Sprachpakete für die lokalisierte Hilfe manuell installieren und die Benutzerschnittstellensprache in dem
Produkt manuell ändern.

Die Eigenschaft TRANSFORMS ist ein Parameter für MsiExec.exe. Das folgende Beispiel verwendet die Eigen-
schaft TRANSFORMS zur automatischen Übertragung einer französischen Installation. Der Installationsassis-
tent erscheint auf französisch, die Benutzerschnittstelle erscheint auf französisch und die Hilfe wird auf
französisch installiert. (Sie können die Sprache der Hilfefunktion auch mit der Eigenschaft HELPCHOICE
überschreiben. Weitere Informationen finden Sie in „Eigenschaften für automatisch übertragene
Installationen” auf Seite 10.) Geben Sie den gesamten Text in einer einzigen Zeile ein.
MsiExec.exe /i "IBM SPSS Statistics 25.msi" /qn /L*v Protokolldatei.txt
INSTALLDIR="C:\Statistics" LICENSETYPE="Network" LSHOST="mylicserver" TRANSFORMS=1036.mst

Die folgenden Sprach-MST-Dateien befinden sich im Verzeichnis Windows\SPSSStatistics\<Architektur>
auf der DVD/CD, wobei <Architektur> für 32bit oder 64bit steht. Wenn Sie ein eImage heruntergeladen
haben, befinden sich diese Dateien im Stammverzeichnis der entpackten eImage-Dateien.

Tabelle 2. MST-Sprachdateien.

Sprache MST-Datei

Deutsch 1031.mst

Englisch 1033.mst

Französisch 1036.mst

Italienisch 1040.mst

Japanisch 1041.mst

Koreanisch 1042.mst

Polnisch 1045.mst

Russisch 1048.mst
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Tabelle 2. MST-Sprachdateien (Forts.).

Sprache MST-Datei

Spanisch 1034.mst

Traditionelles Chinesisch 1028.mst

Vereinfachtes Chinesisch 2052.mst

Automatische Übertragung einer Deinstallation
Hinweis: Wenn Sie den Deinstallationsbefehl automatisch übertragen, gehen die Anpassungen der Endbe-
nutzer verloren. Wenn bestimmte Benutzer ihre Anpassungen benötigen, können Sie diese aus der Vertei-
lung ausschließen und sie bitten, das Produkt manuell zu installieren.

Wenn Sie eine Installation einer neueren Version von IBM SPSS Statistics automatisch übertragen, sollten
Sie gegebenenfalls zuerst eine Deinstallation durchführen. Sie können dies im Hintergrund durchführen
lassen, indem Sie den folgenden Befehl durch einen Push-Vorgang automatisch übertragen. Geben Sie den
gesamten Text in einer einzigen Zeile ein.
MsiExec.exe /X{4762AE15-E5A3-43BF-8822-1CFC70FB147A} /qn /L*v Protokolldatei.txt
ALLUSERS=1 REMOVE="ALL"

Dieser Befehl deinstalliert IBM SPSS Statistics 25. In der folgenden Tabelle sind die Deinstallations-IDs
für diese und frühere Versionen aufgelistet.

Tabelle 3. Deinstallations-IDs für IBM SPSS Statistics.

Version Deinstallations-ID

24.* {4762AE15-E5A3-43BF-8822-1CFC70FB147A}

23.* {C3BA73A4-2A45-4036-8541-4F5F8146078B}

22.* {104875A1-D083-4A34-BC4F-3F635B7F8EF7}

21.* {1E26B9C2-ED08-4EEA-83C8-A786502B41E5}

20.* {2AF8017B-E503-408F-AACE-8A335452CAD2}

19.* {06C43FAA-7226-41EF-A05E-9AE0AA849FFE}

18.* {C25215FC-5900-48B0-B93C-8D3379027312}

17.0.2 {2ECDE974-69D9-47A9-9EB0-10EC49F8468A}

17.0.1

17.0.0

{46B65150-F8AA-42F2-94FB-2729A8AE5F7E}

16.* {621025AE-3510-478E-BC27-1A647150976F}

Ausführen einer unbeaufsichtigten Installation auf Mac- und Linux-
Computern
Eine unbeaufsichtigte Installation erfolgt ohne grafische Benutzeroberfläche und erfordert keine Eingriffe
seitens des Benutzers. IBM SPSS Statistics enthält eine Datei mit den Eigenschaften für das Installations-
programm, mit der Sie diese Art von Installation auf Mac OS- und Linux-Computern durchführen kön-
nen. Die Datei enthält verschiedene Optionen und Beschreibungen zu diesen Optionen.

Verwendung der Datei 'installer.properties'

Die Datei mit den Eigenschaften für das Installationsprogramm, installer.properties, befindet sich in /Linux/
Administration oder /MacOS/Administration im Stammverzeichnis der DVD/CD. Wenn Sie ein eImage he-
runtergeladen haben, befindet sich installer.properties im Ordner Administration des eImage.
1. Kopieren Sie die Datei 'installer.properties' von der DVD/CD oder vom eImage.
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2. Öffnen Sie die kopierte Datei in einem Texteditor.
3. Ändern Sie die benötigten Eigenschaften. Einige Optionen benötigen einen Zeichenfolgewert, andere

dagegen, die einer Auswahl im Installationsassistenten entsprechen, können auf 0 (aus) oder 1 (an) ge-
setzt werden.

Ausführen einer unbeaufsichtigten Installation

Stellen Sie bei Installationen unter Mac OS sicher, dass die unbeaufsichtigte Installation und nicht die in-
teraktive Installation durchgeführt wird. Die unbeaufsichtigte Installation weist die Erweiterung .bin auf
und kann als eImage heruntergeladen werden. Wenn Sie über Installationsdatenträger verfügen, befindet
sie sich auf der DVD/CD unter /MacOS/Administration/.

Anmerkung: Damit das Programm für die unbeaufsichtigte unter Mac OS ausgeführt werden kann, muss
Java installiert sein. Die aktuellen Informationen zu Systemanforderungen finden Sie in den Berichten mit
den detaillierten Systemanforderungen auf der Site des IBM Technical Support unter http://
publib.boulder.ibm.com/infocenter/prodguid/v1r0/clarity/softwareReqsForProduct.html.
1. Führen Sie in einer Terminalanwendung die Installation mit dem Schalter -f aus, gefolgt vom Spei-

cherort der Datei 'installer.properties' in Anführungszeichen. Unter Mac OS und Linux muss die Aus-
führung als 'Root' oder mit dem Befehl sudo erfolgen. Es folgt ein Beispiel unter Linux:
sudo ./setup.bin -f "/root/installer.properties"

Verwalten der Lizenz für gleichzeitig angemeldete Benutzer
Der Lizenzmanager verwaltet die Lizenz für gleichzeitig angemeldete Benutzer. Mithilfe der Anwendung
WlmAdmin, die die Hauptbenutzeroberfläche für den Lizenzmanageradministrator ist, können Sie den
Lizenzmanager verwalten und Informationen zu den verwalteten Lizenzen für gleichzeitig angemeldete
Benutzer anzeigen. Wenn Sie einen Lizenzmanager auf einem Nicht-Windows-System oder einem Remo-
te-Windows-System verwalten, installieren Sie den Lizenzmanageradministrator auf einem separaten Win-
dows-System. Weitere Informationen finden Sie in „Installieren des Lizenzmanageradministrators” auf
Seite 4.

Anmerkung: Weitere Informationen zur Administration finden Sie in der SafeNet-Dokumentation, die
zusammen mit dem Lizenzmanageradministrator installiert wird. Diese Dokumentation finden Sie im
Verzeichnis help\Content des Installationsverzeichnisses des Lizenzmanageradministrators (z. B.
C:\Programme (x86)\IBM\SPSS License Tools\9.7.0.0\help\Content).

Starten der Anwendung WlmAdmin
Wählen Sie folgende Befehle aus dem Menü "Start" von Windows aus:

[Alle] Programme > IBM > SPSS License Tools > <Version> > Sentinel RMS Server Administration

Hinzufügen eines Servers
Bevor Sie einen Lizenzmanager verwalten können, müssen Sie in der Anwendung WlmAdmin einen Ser-
ver dafür hinzufügen. Sie haben zwei Optionen, um den Server hinzuzufügen.

Manuelles Hinzufügen eines Servers
1. Wählen Sie die folgenden Befehle aus den Menüs der Anwendung WlmAdmin aus:

Edit > Defined Server List

2. Geben Sie in dem Dialogfeld "Defined Server List" den Namen oder die IP-Adresse des Servers ein,
auf dem der Lizenzmanager läuft.

3. Klicken Sie auf Add.
4. Klicken Sie auf OK.
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Der Server wird jetzt in den Listen der Server im linken Fensterbereich der Anwendung WlmAdmin an-
gezeigt.

Anzeigen einer Liste der Server im Teilnetz
1. Klicken Sie im linken Fensterbereich der Anwendung WlmAdmin auf das Zeichen + neben Subnet

Servers.

Eine Liste von Servern für Lizenzmanager in Ihrem Teilnetz wird angezeigt. Wenn Sie einen bestimmten
Server mit diesem Verfahren nicht finden, fügen Sie ihn wie oben beschrieben manuell hinzu.

Abrufen von Protokollinformationen
Wenn Endbenutzer beim Abruf von Lizenzen Schwierigkeiten haben, können die Protokolldateien mögli-
cherweise hilfreiche Informationen enthalten. Sie können die Umgebungsvariable LSERVOPTS sowie die
Optionen -f <Traceprotokolldatei> und -l <Nutzungsprotokolldatei> verwenden, um anzugeben, dass
Protokolldateien erstellt werden sollen. Weitere Informationen zu dieser Umgebungsvariablen und den
zugehörigen Optionen finden Sie in der SafeNet-Dokumentation im Verzeichnis Content des Installations-
verzeichnisses des Lizenzmanageradministrators.

Anzeigen der Details zu einer Lizenz
Sie können Details zu Lizenzen anzeigen, die Sie entweder manuell oder über den Lizenzierungsassisten-
ten hinzugefügt haben.
1. Klicken Sie im linken Fensterbereich der Anwendung WlmAdmin auf das Zeichen + neben Lizenzma-

nagerserver, um die Lizenz(en) anzuzeigen.
2. Klicken Sie auf den Namen der Lizenz. Im rechten Fensterbereich werden Details zu der Lizenz ange-

zeigt. Die Lizenzen werden mithilfe von Codes identifiziert. Der erste Teil des Codes verweist auf die
Funktion. Der zweite Teil verweist auf die Version.

Anzeigen der mit den Funktionscodes verknüpften Namen
1. Wechseln Sie über eine Eingabeaufforderung in das Installationsverzeichnis des Lizenzmanageradmi-

nistrators.
2. Geben Sie lmshowlic <Server> (Windows) oder ./lmshowlic <Server> (andere Betriebssysteme) ein.

Dabei stellt <Server> den Namen oder die IP-Adresse des Servers dar, auf der Lizenzmanager ausge-
führt wird.

In der Ausgabe werden alle Funktionen nach Produkt und Version in Gruppen geordnet aufgeführt, die
auf dem Server verfügbar sind.

Einrichten von redundanten Lizenzservern
Sie können mehrere redundante Lizenzserver einrichten, die dieselben Benutzer unterstützen. Mit redun-
danten Servern können Sie Unterbrechungen verhindern, die durch den Absturz eines Servers bedingt
sind. Im Falle eines Serverabsturzes kann ein anderer redundanter Server die Lizenzverwaltung überneh-
men.

Für die in den folgenden Schritten beschriebene Aktivierung der Redundanzfunktion benötigen Sie einen
speziellen Lizenzcode. Wenden Sie sich für Unterstützung beim Erstellen eines redundanten Lizenzschlüs-
sels oder bei anderen Fragen zur Lizenzierung telefonisch oder per Mail an den IBM Support. Kontaktin-
formationen finden Sie unter http://www.ibm.com/planetwide.

Es muss eine ungerade Anzahl von Servern (mindestens drei) vorhanden sein und die Mehrzahl der Ser-
ver muss jeweils gleichzeitig ausgeführt werden. Wenn zum Beispiel drei redundante Lizenzserver exis-
tieren, müssen von diesen zwei ausgeführt werden.
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Vorbereiten der einzelnen redundanten Lizenzserver
1. Installieren Sie den Lizenzmanager. Weitere Informationen finden Sie in „Installieren des Concurrent

License Managers” auf Seite 2.
2. Wechseln Sie über eine Eingabeaufforderung in das Installationsverzeichnis des Lizenzmanagers.
3. Rufen Sie den Sperrcode für die einzelnen Server-Computer ab. Geben Sie an der Eingabeaufforde-

rung echoid (Windows) bzw. ./echoid (anderes Betriebssystem) ein.
4. Notieren Sie den Sperrcode. Für die nächsten Schritte ist der Sperrcode erforderlich.
5. Wiederholen Sie diese Schritte für jeden redundanten Lizenzserver.

Aktivieren der redundanten Lizenzen
1. Rufen Sie das IBM SPSS License Key Center auf (https://spss.subscribenet.com/control/ibmp/login).
2. Erstellen Sie einen Autorisierungscode für gleichzeitig angemeldete Benutzer.
3. Klicken Sie nach der Erstellung des Autorisierungscodes für gleichzeitig angemeldete Benutzer auf

den Code und blättern Sie nach unten, bis die Felder für Sperrcode angezeigt werden. Nun können
Sie dem Lizenzschlüssel mehrere Sperrcodes hinzufügen.

4. Geben Sie die Sperrcodes aus den vorherigen Schritten in die entsprechenden Felder ein.
5. Klicken Sie auf Übergeben.

Einrichten eines Pools mit redundanten Lizenzservern
1. Wenn auf einem oder mehreren redundanten Lizenzservern ein Lizenzmanager ausgeführt wird, be-

enden Sie diesen auf jedem betroffenen Computer.
2. Wählen Sie die folgenden Befehle aus den Menüs der Anwendung WlmAdmin aus:

Edit > Redundant License File

Dadurch wird die Anwendung WrlfTool geöffnet.
3. Wählen Sie die folgenden Befehle aus den Menüs der Anwendung WrlfTool aus:

File > New

4. Klicken Sie für jeden redundanten Lizenzserver auf Add, um jeweils den Hostnamen und die IP-Ad-
resse anzugeben.

5. Ordnen Sie die redundanten Lizenzserver in der Reihenfolge an, in der sie verwendet werden sollen.
Der erste Server in der Liste ist der primäre Server.

6. Klicken Sie auf Add License, um die Lizenzen hinzuzufügen, die Sie vom Kundendienst oder Ihrer
lokalen Niederlassung erhalten haben. Achten Sie bei mehreren Lizenzen darauf, dass Sie auch wirk-
lich alle hinzugefügt haben.

7. Klicken Sie auf OK.
8. Klicken Sie abschließend auf Done.

Speichern der redundanten Lizenzdatei
1. Wählen Sie die folgenden Befehle aus den Menüs der Anwendung WrlfTool aus:

File > Save As

2. Speichern Sie die redundante Lizenzdatei (lservrlf) an einem leicht zugänglichen Speicherort. In den
nächsten Schritten müssen Sie die Datei kopieren.

Konfigurieren der redundanten Lizenzserver
1. Kopieren Sie die redundante Lizenzdatei (lservrlf) unter Windows in den Unterordner winnt des Li-

zenzmanagerinstallationsverzeichnisses. Wenn Sie die Standardposition akzeptiert haben, wechseln Sie
in den Ordner C:\Programme (x86)\Common Files\SafeNet Sentinel\Sentinel RMS License Manager.
Auf anderen Betriebssystemen kopieren Sie die Datei direkt in das Lizenzmanagerinstallationsver-
zeichnis. Es müssen mindestens drei redundante Lizenzserver vorhanden sein.

2. Starten Sie auf allen redundanten Lizenzservern den Lizenzmanager.
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Konfigurieren des Computers des Endbenutzers

Wenn ein Endbenutzer das Produkt installiert, gibt der Benutzer alle redundanten Server an. Die Namen
oder IP-Adressen der Server werden dabei durch Tilden getrennt (z. B. Server1~Server2~Server3). Das
Setup-Programm fügt dann dem Computer des Endbenutzers die erforderlichen Konfigurationsinformati-
onen hinzu. Wenn das Produkt bereits auf den Computern installiert ist, können Sie die folgenden Schrit-
te ausführen, um die Konfigurationsinformationen hinzuzufügen. Sie können auch zunächst eine Deins-
tallation und anschließend eine neue Installation übertragen, bei der alle Server festgelegt sind.
Informationen zum automatischen Übertragen von Installationen finden Sie in „Übertragen einer Installa-
tion an Windows-Computer” auf Seite 9.
1. Öffnen Sie die Datei spssprod.inf in einem Texteditor. Unter Windows befindet sich diese Datei auf

dem Desktop-Computer im Installationsverzeichnis des Produkts. Unter Mac OS befindet sich diese
Datei im App-Bundle unter Contents/bin. Unter Linux befindet sich diese Datei im Unterverzeichnis
bin des Produktinstallationsverzeichnisses.

2. Ändern Sie den Wert von DAEMONHOST in die durch eine Tilde (~) getrennten Namen oder IP-Adressen
des Servers. Beispiel:
DAEMONHOST=Server1~Server2~Server3

3. Speichern Sie spssprod.inf.

Konfigurieren von Pendlerlizenzen
Mit Pendlerlizenzen können Endbenutzer Lizenzen aus dem Lizenzmanager auschecken, sodass sie diese
Lizenzen verwenden können, auch wenn sie nicht mit dem Netz verbunden sind. Unter Windows sind
Pendlerlizenzen standardmäßig nicht aktiviert. Auf anderen Betriebssystemen sind sie dagegen standard-
mäßig aktiviert. Anweisungen für das eigentliche Auschecken der Pendlerlizenz finden sich in den Instal-
lationshinweisen für Endbenutzer.

Sie können den Prozentsatz der Lizenzen auf dem Lizenzmanagerserver beschränken, die für den mobi-
len Zugriff aktiviert werden. Es empfiehlt sich, die Anzahl der Pendlerlizenzen zu beschränken. Damit
wird verhindert, dass sich alle verfügbaren Lizenzen im mobilen Einsatz befinden. Wenn der angegebene
Prozentsatz an Lizenzen von mobilen Anwendern aufgebraucht wurde, stehen keine weiteren Lizenzen
zur Verfügung, bis die mobilen Lizenzen ablaufen oder wieder eingecheckt werden. Sie können außerdem
die Dauer festlegen, für die mobile Lizenzen ausgecheckt werden können. In der Standardeinstellung be-
trägt die maximale Dauer 7 Tage.

Wichtig: Wenn Sie redundante Lizenzserver mit Pendlerlizenzen verwenden, gestattet nur der primäre
Lizenzserver den Benutzern, Pendlerlizenzen aus- und einzuchecken. Bei einem Ausfall des primären Li-
zenzservers können die Benutzer keine Lizenzen ein- und auschecken.

Festlegen des Prozentsatzes der verfügbaren Pendlerlizenzen
1. Erstellen Sie auf dem Lizenzmanagerserver eine Umgebungsvariable mit dem Namen LSERVOPTS. Die-

se Variable wird unter Windows während der Lizenzmanagerinstallation erstellt, sodass Sie diesen
Schritt nur für die anderen Betriebssysteme durchführen müssen.

2. Ändern Sie den Wert der Umgebungsvariablen LSERVOPTS, indem Sie -com <Prozentsatz> aufnehmen.
Hierbei stellt <Prozentsatz> einen numerischen Wert zwischen 0 und 100 dar, der den Prozentsatz an
Lizenzen angibt, die für den mobilen Zugriff verfügbar sind. Mit der Angabe 0 stehen keine Lizenzen
für den mobilen Zugriff zur Verfügung. Dieser Schalter ist unter Windows standardmäßig enthalten
und auf 0 festgelegt.

3. Starten Sie den Computer neu, auf dem der Lizenzmanager ausgeführt wird.

Festlegen der maximalen Zeitdauer für Pendlerlizenzen

Die maximale Zeitdauer, für die die Endbenutzer eine Pendlerlizenz auschecken können, wird durch die
Einstellung CommuterMaxLife in der Datei spssprod.inf auf dem Desktop-Computer angegeben. Unter Win-
dows befindet sich diese Datei auf dem Desktop-Computer im Installationsverzeichnis des Produkts. Un-
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ter Mac OS befindet sich diese Datei im App-Bundle unter Contents/bin. Unter Linux befindet sich diese
Datei im Unterverzeichnis bin des Produktinstallationsverzeichnisses. Öffnen Sie die Datei spssprod.inf und
suchen Sie nach CommuterMaxLife . Legen Sie den Wert dieser Option auf die maximale Anzahl von Tagen
fest, für die die Endbenutzer eine Pendlerlizenz auschecken können. Der Wert sollte eine Zahl zwischen 1
und 30 sein. Sie können diesen Wert auch festlegen, wenn Sie die Installation automatisch übertragen.
Weitere Informationen finden Sie in „Übertragen einer Installation an Windows-Computer” auf Seite 9.

Hinweis: Diese Funktion arbeitet mit einer Datums-, nicht mit einer Zeitangabe. Wenn Sie zum Beispiel
die Option CommuterMaxLife auf einen Tag setzen und dann eine Lizenz um 9.00 Uhr auschecken, wird
diese Lizenz nicht vor Mitternacht des Folgetages wieder eingecheckt. Auch wenn also CommuterMaxLife
auf einen Tag eingestellt ist, behält der Benutzer die Lizenz tatsächlich 39 Stunden lang.

Abrufen einer Liste der ausgecheckten Lizenzen in der Befehlszeile

Sie können ermitteln, welche Benutzer Lizenzen ausgecheckt haben.
1. Wechseln Sie über eine Eingabeaufforderung in das Installationsverzeichnis des Lizenzmanageradmi-

nistrators.
2. Geben Sie Ismon<Server> (Windows) oder ./lsmon <Server> (andere Betriebssysteme) ein. Dabei stellt

<Server> den Namen oder die IP-Adresse des Servers dar, auf der Lizenzmanager ausgeführt wird.
Sie können den Namen des Lizenzservers auslassen, wenn Sie nur die ausgecheckten Lizenzen für
den Server "localhost" anzeigen möchten.

Abrufen einer Liste der ausgecheckten Lizenzen in der Anwendung WlmAdmin

Sie können ausgecheckte Lizenzen auch in der Anwendung WlmAdmin anzeigen:
1. Klicken Sie im linken Fensterbereich der Anwendung WlmAdmin auf das Zeichen + neben dem Li-

zenzmanagerserver.
2. Klicken Sie auf das Zeichen + neben Clients. Die Clients, die die Lizenz für gleichzeitig angemeldete

Benutzer nutzen, werden aufgelistet. Wenn keine Clients aufgelistet werden, verwendet kein Benutzer
die Lizenz für gleichzeitig angemeldete Benutzer.

3. Wählen Sie einen bestimmten Client aus, um anzuzeigen, ob der Client eine Lizenz ausgecheckt hat.
Überprüfen Sie nach der Auswahl den Bereich "Detaillierte Informationen" im rechten Fensterbereich.

Konfigurieren von Lizenzreservierungen
Sie können eine Reservierungsdatei erstellen, in der angegeben wird, wie viele Lizenzen für bestimmte
Benutzer oder Benutzergruppen reserviert werden. Die Benutzer werden durch Netz-IDs oder Compu-
ternamen (nicht durch IP-Adressen) identifiziert. Sie können zum Beispiel eine Reservierungsdatei einrich-
ten, mit der die Lizenz für eine Gruppe von Hauptbenutzern reserviert wird. Für diese Benutzer werden
die Lizenzen immer verfügbar sein. Mithilfe der Reservierungen können Sie auch verhindern, dass be-
stimmte Benutzer einen Zugriff auf die Lizenz bekommen.

Erstellen einer neuen Reservierungsdatei
1. Wählen Sie die folgenden Befehle aus den Menüs der Anwendung WlmAdmin aus:

Edit > Reservation File

Dadurch wird die Anwendung 'Wlsgrmgr' geöffnet.
2. Wählen Sie die folgenden Befehle aus den Menüs der Anwendung 'Wlsgrmgr' aus: File > New.

Hinzufügen von Lizenzen und Benutzer zur Reservierungsdatei
1. Wählen Sie die folgenden Befehle aus den Menüs der Anwendung 'Wlsgrmgr' aus:

Feature > Add

2. Klicken Sie im ersten Bildschirm des Assistenten auf Weiter.
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3. Geben Sie den Funktionscode für die entsprechende Lizenz an, die Sie reservieren möchten. Informati-
onen zum Abrufen der Funktionscodes für die entsprechenden Lizenzen finden Sie in „Anzeigen der
Details zu einer Lizenz” auf Seite 15. Legen Sie außerdem eine bestimmte Version fest. Geben Sie die
Version hierbei so ein, wie sie in der Anwendung 'WlAdmin' angezeigt wird (z. B. 160). Die Version
ist nicht optional. Ignorieren Sie die Steuerelemente für "Capacity", weil Lizenzen dieses Typs nicht
unterstützt werden.

4. Klicken Sie auf Weiter.
5. Geben Sie für die Gruppe von Benutzern einen Namen an. Der Name ist willkürlich, er sollte jedoch

aussagekräftig sein (z. B. Vertrieb).
6. Geben Sie die Anzahl der Lizenzen an, die für diese Gruppe reserviert werden sollen. Die Gruppen-

mitglieder können auf alle Lizenzen zugreifen. Die Anzahl von Lizenzen, die Sie angeben, steht je-
doch nicht mehr für die Benutzer zur Verfügung, die nicht Mitglied dieser Gruppe sind. Dies bedeu-
tet: Wenn Sie von 10 Lizenzen 5 Lizenzen reservieren, können Mitglieder dieser Gruppe über 10
Lizenzen verfügen, während den anderen Benutzern nur 5 Lizenzen zur Verfügung stehen.

7. Klicken Sie im Fenster "Members" auf Add, um einen der Gruppe zugehörigen Benutzer oder Compu-
ternamen (keine IP-Adressen verwenden) anzugeben. Benutzer und Computer, die der Gruppe ange-
hören, können die reservierten Lizenzen verwenden. Benutzer und Computer, die der Gruppe nicht
angehören, können nicht auf die reservierten Lizenzen zugreifen. Geben Sie so viele Benutzer und
Systeme wie erforderlich an. Beachten Sie, dass sich die Gruppen gegenseitig ausschließen müssen.
Daher können verschiedenen Gruppen für dieselbe Lizenz nicht dieselben Benutzer oder Computer
enthalten.

8. Klicken Sie auf Fertigstellen, wenn Sie der Gruppe alle Benutzer hinzugefügt haben.
9. Fügen Sie nach Bedarf weitere Gruppen oder Lizenzen hinzu. Sie können Lizenzen und Gruppen

auch ändern oder löschen, indem Sie auf diese mit der rechten Maustaste klicken und die Option Pro-
perties auswählen.

Speichern der Reservierungsdatei
1. Wählen Sie folgenden Befehle aus den Menüs aus, wenn Sie die Reservierungsdatei fertiggestellt ha-

ben:
File > Save As

2. Speichern Sie die Datei an einem leicht zugänglichen Speicherort. Im nächsten Schritt müssen Sie die
Datei kopieren.

3. Um die Einstellung zu aktivieren, dass der Lizenzserver die Datei lsreserv beim Start automatisch fin-
det, kopieren Sie die Datei unter Windows in den Unterordner winnt im Lizenzmanagerinstallations-
verzeichnis. Wenn Sie die Standardposition akzeptiert haben, wechseln Sie in den Ordner
C:\Programme (x86)\Common Files\SafeNet Sentinel\Sentinel RMS License Manager. Auf anderen
Betriebssystemen kopieren Sie die Datei direkt in das Lizenzmanagerinstallationsverzeichnis.

4. Wenn Sie allen redundanten Servern dieselben Reservierungen zuweisen möchten, kopieren Sie die
Reservierungsdatei (lsreserv) auf jeden Server.

5. Starten Sie abschließend jeden Lizenzmanager neu.

Starten und Stoppen des Lizenzmanagers
Die Methode zum Starten des Lizenzmanagers hängt von Ihrem Betriebssystem ab.

Windows

Auf Windows-Computern wird der Lizenzmanager als Systemdienst ausgeführt. Der Dienst wird stan-
dardmäßig automatisch gestartet. Falls Sie ihn dennoch einmal manuell starten müssen, gehen Sie wie
folgt vor:
1. Doppelklicken Sie in der Windows-Systemsteuerung auf Verwaltung.
2. Doppelklicken Sie auf Dienste.
3. Suchen Sie in der Liste der Dienste die Option Sentinel RMS License Manager.
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4. Klicken Sie mit der rechten Maustaste auf den Dienst und wählen Sie die Option Starten oder Been-
den aus.

Andere Betriebssysteme

Auf anderen Betriebssystemen wird der Lizenzmanager als Dämonprozess ausgeführt. Führen Sie zum
manuellen Starten die folgenden Schritte aus. Sie können den Lizenzmanager auch zum automatischen
Starten konfigurieren (Anweisungen folgen).
1. Wechseln Sie an der Eingabeaufforderung in das Installationsverzeichnis des Lizenzmanagers.
2. Starten. Geben Sie als Root an der Eingabeaufforderung ./lserv & ein und drücken Sie die Eingabe-

taste.
3. Beenden. Geben Sie als Root ./lsrvdown <Hostname> an der Eingabeaufforderung ein, wobei <Hostna-

me> der Netzname des Computers ist, auf dem der Lizenzmanager ausgeführt wird. Drücken Sie
dann die Eingabetaste.

Konfigurieren des Lizenzmanagers für den automatischen Start
Windows
1. Doppelklicken Sie in der Windows-Systemsteuerung auf Verwaltung.
2. Doppelklicken Sie auf Dienste.
3. Suchen Sie in der Liste der Dienste die Option Sentinel RMS License Manager.
4. Klicken Sie mit der rechten Maustaste auf den Dienst und wählen Sie die Option Eigenschaften aus.
5. Legen Sie als "Starttyp" Automatisch fest.
6. Klicken Sie auf OK.

Andere Betriebssysteme
1. Fügen Sie einer der Startdateien des Betriebssystems den Eintrag ./lserv & hinzu.

Deinstallieren des Lizenzmanagers
Windows
1. Wählen Sie folgende Befehle aus dem Menü "Start" von Windows aus:

Einstellungen > Systemsteuerung

2. Doppelklicken Sie auf Software.
3. Wählen Sie Sentinel RMS License Manager und klicken Sie anschließend auf Entfernen.
4. Klicken Sie auf Ja, wenn Sie aufgefordert werden, den Lizenzmanager zu entfernen.

Andere Betriebssysteme
1. Wechseln Sie an der Eingabeaufforderung in das Installationsverzeichnis des Lizenzmanagers.
2. Beenden Sie den Lizenzmanager, indem Sie als Root an der Eingabeaufforderung ./lsrvdown

<Hostname> eingeben, wobei <Hostname> der Netzname des Computers ist, auf dem der Lizenzmana-
ger ausgeführt wird. Drücken Sie dann die Eingabetaste.

3. Löschen Sie das Installationsverzeichnis des Lizenzmanagers.

Deinstallieren des Lizenzmanageradministrators
1. Wählen Sie folgende Befehle aus dem Menü "Start" von Windows aus:

Einstellungen > Systemsteuerung

2. Doppelklicken Sie auf Software.
3. Wählen Sie IBM SPSS License Tools aus und klicken Sie anschließend auf Entfernen.
4. Klicken Sie auf Ja, wenn Sie aufgefordert werden, die parallelen Lizenzierungstools zu entfernen.
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Fehlerbehebung bei Problemen mit den Desktop-Computern
Gehen Sie folgendermaßen vor, wenn die Desktop-Computer der Endbenutzer den Lizenzmanager nicht
finden können:
1. Führen Sie lswhere aus, um zu überprüfen, ob der Desktop-Computer den Netzcomputer finden

kann, auf dem der Lizenzmanager ausgeführt wird. Weitere Informationen finden Sie in „Ausführen
von "Iswhere"”.

2. Stellen Sie sicher, dass der Lizenzmanagerservice auf dem Netzcomputer ausgeführt wird.
3. Überprüfen Sie die entsprechende Datei spssprod.inf. Unter Windows befindet sich diese Datei auf dem

Desktop-Computer im Installationsverzeichnis des Produkts. Unter Mac OS befindet sich diese Datei
im App-Bundle unter Contents/bin. Unter Linux befindet sich diese Datei im Unterverzeichnis bin des
Produktinstallationsverzeichnisses. Öffnen Sie die Datei spssprod.inf und stellen Sie sicher, dass für
DAEMONHOST der richtige Name bzw. die richtige IP-Adresse des Computers festgelegt ist, auf dem der
Lizenzmanager ausgeführt wird. Wenn Sie redundante Server einsetzen, müssen alle Namen bzw. IP-
Adressen angegeben werden. Die einzelnen Namen werden durch eine Tilde (~) getrennt. Wenn es
sich beispielsweise bei den Lizenzmanagercomputern um SERVER1, SERVER2 und SERVER3 handelt,
wird DAEMONHOST auf SERVER1~SERVER2~SERVER3 gesetzt.

Ausführen von "Iswhere"
lswhere kann über den Desktop-Computer eines Endbenutzers ausgeführt werden, um zu ermitteln, auf
welchem Computer der Concurrent License Manager ausgeführt wird.
1. Wechseln Sie per Eingabeaufforderung in folgendes Verzeichnis:
v Windows. <Installationsverzeichnis>

v Mac OS. <Installationsverzeichnis>/<Produkt>.app/Contents/bin

v Linux. <Installationsverzeichnis>/bin

2. Geben Sie lswhere (Windows) bzw. ./lswhere (Linux und Mac) ein.

Service und Support
Um den Technical Support von IBM zu kontaktieren, rufen Sie http://www.ibm.com/support auf und
senden Sie eine Fallbeschreibung. Sie müssen sich beim Technical Support von IBM registrieren, falls Sie
das nicht schon früher getan haben.

IBM bietet außerdem regelmäßig öffentliche Schulungsseminare für IBM Produkte. Die Ausbildung kann
auch bei Ihnen vor Ort erfolgen. Informationen zu Schulungsseminaren finden Sie unter http://
www.ibm.com/training/spss.
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